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1. Install

Prepare for a computer to setup software
1. CPU for Pentium IV 2.0GHz or more than.
2. Disk is best has above 10G,memory 512M and installation defend virus software.
3. Operating system must Windows 200/2003/XP Pro.
4. Display mode, 16-bit, 1024x768 is recommended
5. 4X or more speed CD-ROM

Install UltraPrint

1. Put the UltraPrint CD in CD-ROM,the software auto Run, setup and jump a dialog like this

Notes please click the setup program if it’s not autorun.

Install Before
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1. Follow the setup guide until the setup is finish.

2. Insert the dongle in computer, then run UltraPrint RIP.
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2 Print guide 

Printer settings 
 
1. In the “File” menu to choose “Printer Setup”. 

 
 
 
2. Select a printer, click ”Default” button, to set the default printer. 
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3. Set printer property— select the printer, click ”property” button, than jump a dialog like this 

 
Notes: TCP/IP is network print, FILE is print to file, DirectSend is print to machine. 
 

Canvas settings 

1. Select “New” ” in “file” menu or clic k “ ”of toolbar 
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2. Click “Canvas settings”, complete canvas size.settings. 

 
 

Insert and nesting image 

1. Select “Import image” or click “ ”. 
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2. After insert image, you can nesting image with the nesting toolbar in the bottom 

 
 

Change image output size 
Select a image and click right button of mouse, select “output size:” or user shortcut key “Shift+0” 
to change image output size, then jump a dialog like this  
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Image information 
Click right button of mouse in image, choose “Image Info”, then jump a dialog like this. 

 

  

Print sure  

1. Finish the nesting, please click ” ” to show the print sure dialog, please make sure print 

parameter: medium, resolution, color, pass, port. The program will auto matching the curve 
after finish this. finally click ”Print” to output the canvas. 
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Print progress 
 
You can click “cancel” to cancel priting if you find mistake. 

 

 

Save canvas  
 

Click save canvas “ ” to save this image and your nesting after printed. (you can click “ ” to 

get back last state next time.) 
 
Notes:  You can have look at “the first print” in “Demo” directory in CD, It’s introduce the 
content upwards. 
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3. General function 

User Interface 
 

 
 

Rotate image  
 
Click “Rotate” to set image’s rotate angle and mirror image 
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Group and ungroup 
 
Select more than one picture, click right button of  mouse, then select 
Group”Ctrl+G”, Ungroup”Ctrl+U”.  

 
 
Tile image  
 If the picture more than the size or the size of the paper to cut into 
several parts, Click "Tile image" in “Edit” menu, show window like this 
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Nesting  
 

 Align left 

 Align right 

 Align top 

 Align bottom 

 Center horizontal 

 Center vertical 

 Same width 

 Same height 

 Same size 

 Space across 

 Space down 
Notes: More alignment with 'activated image' as a reference. 

   
Difference between “activated image” and “selected image”: the selected 

flag of activated image is solid, the selected flag of activated image 
is hollow.  

 

Print Sample 
 

This function is to facilitate the canvas you want to see in advance 
of the output of the output canvas, the canvas for customization of a sample 
product. In the "Edit" menu, select "custom sample product." Pop-up dialog 
following: 
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Copy and Step Repeat 

Select a image, click  in the toolbar or 'copy' in 'Edit' menu, then click 

 in the toolbar, to settings “Step & Repeat”. 
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Color Manager 
 
Version 3.20 j oined the Color Manager, when users replaced  the current 

material or ink or without the corresponding icc curve, the user can modify 
the current curve or create a new curve. Click “Color manager” in “Setup” 
menu. 

Notes: Please use the function careful. 
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4. Error code 

 

Code Description Comment 

0 No error Execute successfully  

2 Not find the file Maybe source file has been deleted or modified. 

3 Not find the path Maybe source file has been deleted or modified.  

6 False sentence 

handle 
False sentence handle, the possible reason is the curve 

which establishes at present is invalid 

32 Another procedure is 

using this document, 

the progress can't 

visit 

The procedure of being different from is carrying out 

this document, can't visit enough now 

  

112 The disk space isn't 

enough 
May be a disk space already full, please delete in that 

disk don't of the document replaces larger disk to used 

for depositing a temporary document perhaps 

If your output's document is big in the 4 GBs, please 

confirm the document format of your disk as NTFS 

  

113 Try to move index to 

the file head 

May be is contain special image floor 

10053 In your main engine's 

software gave up one 

already connection 

which establishes 

In your main engine's software gave up one already 

connection which establishes 

10054 Do not send data by 

means of net port 
Maybe the net wire is not inserted correctly or the link 

of sever has break.  

10061 Do not link to net 

port normally 
Maybe the net wire is not inserted correctly or the IP 

address/port are not setup correctly.  

20001 The appointed file is 

bad image file 
Maybe the source image file is bad. 

20002 Do not identify the 

image format of the 

appointed file 

Maybe UltraPrint do not support the object file.  

20003 Not support the color 

space of this image 

format  

Maybe UltraPrint do not support the color space of the 

object file. 
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20004 Rotate image failed maybe less memory occurred or too many objects in one 

operation.  

20005 Detach channels 

failed 
Commonly indicates not enough memory  

20006 Zoom image failed Commonly indicates not enough memory  

20007 Halftone image 

failed 
Commonly indicates not enough memory  

20008 Save image failed Commonly indicates not enough memory  

20009 Sharpen image failed Commonly indicates not enough memory  

20010 Pre-processing 

failed 
Commonly indicates not enough memory  

20011 The number of canvas 

has exceed the stated 

value 

The number of canvas exceed the upper limit 

20012 Not support this 

image format 
UltraPrint do not support current processing image 

format.  

20013 Decode image failed UltraPrint do not support this type of encoding format. 

20014 The size of image has 

exceed stated value 
Maybe the size of current processed image has exceed 

percent of the range of canvas, please define the size 

of file again and do this operation.  

20015 There is not enough 

canvas space 
There is not enough canvas space. The operation of 

appointed numbers image pasting can't completed. 

20016 The size of canvas 

has been modified 
The size of canvas has been modified. Operation can't 

completed normally.  

20017 Not support mirror 

status operation 
Can't deal with mirror image, please transform it into 

non-mirror status and try again.  

20018 The beginning starts 

to turn to print mode 

a mistake 

May be because of want for relevant document, please re- 

start software, if still is wrong, re- install after 

pleasing unload software 

20019 Print to have no 

picture inside 

district 

  

It have no portrait in the effectively printing of the 

choice district 

20101 Open file failed Open file failed. Please restart UltraPrint and do this 

operation 

20102 Setup file pointer 

failed 
Setup file pointer failed. Please restart UltraPrint and 

do this operation  
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20103 Read file failed Read file failed. Please restart UltraPrint and do this 

operation 

20104 Write file failed Please confirm there is enough disk space free. Then 

restart UltraPrint and do this operation 

20105 Create temporary 

file failed 
Create temporary file failed, Please restart UltraPrint 

and do this operation  

20106 Not support file size The size of file is invalid, please confirm the file is 

not bad  

20107 Create preview file 

failed 
Please confirm that the output port is file port and has 

setup right output path  

20108 Write preview file 

failed 
Please confirm there is enough disk space free. Then 

restart UltraPrint and do this operation  

20109 Not support this file 

format provisionally 
The canvas has not-supported file format, please 

transform it into supported format and try again  

20110 Lack of relevant item 

print in INI files 
Please confirm whether the current print setup of INI 

file is matching with current printer 

20201 Enumerate encryption 

lock failed 
Please confirm that the encryption lock has inserted. 

When the problem has been exist, please replace 

encryption lock  

20202 Open encryption lock 

failed 
Please confirm that the encryption lock has inserted. 

When the problem has been exist, please replace 

encryption lock  

20203 Modify encryption 

lock path failed 
Please confirm that the encryption lock has inserted. 

When the problem has been exist, please replace 

encryption lock  

20204 Verify encryption 

lock failed 
Please confirm that the encryption lock has inserted. 

When the problem has been exist, please replace 

encryption lock  

20205 Execute encryption 

lock failed 
Please confirm that the encryption lock has inserted. 

When the problem has been exist, please replace 

encryption lock  

20206 Close encryption 

lock failed 
Please confirm that the encryption lock has inserted. 

When the problem has been exist, please replace 

encryption lock  

20207 Encrypt data failed Commonly indicates not enough memory  

20208 Un-encrypt data 

failed 
Commonly indicates not enough memory  

20301 Access system Commonly indicates not enough memory  
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resource unlawfully

20302 Enough memory Commonly indicates not enough memory 

20303 Create threads 

failed

Commonly indicates not enough memory 

20304 Create event failed Commonly indicates not enough memory 

20305 Bind mapping files 

failed

Commonly indicates not enough memory 

20306 Create mapping files 

failed

Commonly indicates not enough memory 

20307 Close mapping files 

failed

Commonly indicates not enough memory 

20308 Release mapping 

files failed

Commonly indicates not enough memory 

20309 Can't find the 

appointed windows

please confirm the printing management set of UltraPrint

has being opened 

20401 Open input ICC failed please confirm whether the appointed ICC Profile files 

exist in input ICC folder

20402 Open output ICC 

failed

please confirm whether the appointed ICC Profile files 

exist in output ICC folder 

20403 Creating ICC 

transform failed

please confirm matching the number of output color with 

please make sure whether it’s support the color or It 

appointed ICC color numbers. i.e. you must use six color 

ICC to control outputing six color 

20404 Transforming color 

space failed

please confirm matching the number of output color with 

appointed ICC color numbers. You can restart the 

UltraPrint and continue the same operation 

is not matching file format 

20405 Not support current 

Not support this 

color transform mode 

 color mode now

ICC transform for appointed color space

20501

20502
Initialize

arithmetic template 

file failed

May be it's lost arithmelate of files or file mangle

20503 File head coding 

failed

Maybe the decode file is not matching,please make sure 

the edition and try again

20504 Data compress failed Maybe the decode file is not matching,please make sure 

the edition and try again

20505 File end coding Maybe the decode file is not matching,please make sure 
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failed the edition and try again 

20506 Create whithe data 

failed 
Maybe the decode file is not matching,please make sure 

the edition and try again 

20601 Start printing error Maybe the drive file is not matching,please make sure 

the edition and try again  

20602 Send data error Maybe the drive file is not matching,please make sure 

the edition and try again  

20603 Stop printing error Maybe the drive file is not matching,please make sure 

the edition and try again  

20604 Cancel printing 

error  
Maybe the drive file is not matching,please make sure 

the edition and try again  

 
 
 
 

5. Customer support 

 
If you meet problems when using our system, you can ask for help from 'online 

help' (press F1). If the problem can't be solved yet, you can ask for help 

through these two ways: 
 
1、Inquire to the sales dealer. 

 

2、Contact us directly through the following ways  

     

    Http://www.hosonsoft.com 

  
    E-mail:support@hosonsoft.com  
           UltraPrint@163.com 

 


